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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits,
software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and
damages incurred by you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving
patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or
technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm,
application examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas
Electronics or others.

You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas
Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration,
modification, copy or otherwise misappropriation of Renesas Electronics products.

Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended

applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment;
home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication
equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life

or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (space and

undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas

Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas

Electronics product for which the product is not intended by Renesas Electronics.

When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes,
"General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are
within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation
characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out
of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them
against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of
Renesas Electronics products, such as safety design for hardware and software including but not limited to redundancy, fire control and
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as
warranty for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please
evaluate the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each
Renesas Electronics product. Please investigate applicable laws and regulations that regulate the inclusion or use of controlled
substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in
compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses
occurring as a result of your noncompliance with applicable laws and regulations.

Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use,
or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall not use Renesas Electronics products or
technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction,
such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for
delivering such weapons, (2) any purpose relating to the development, design, manufacture, or use of conventional weapons, or (3) any
other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics
products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any
other party will engage in the activities described above. When exporting, selling, transferring, etc., Renesas Electronics products or
technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments
of the countries asserting jurisdiction over the parties or transactions.

Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms
and conditions described in this document, including this notice, and hold Renesas Electronics harmless, if such misuse or violation results
from your resale or making Renesas Electronics products available any third party.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or
Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned

subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.3.0-1 November 2016)




General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well
as any technical updates that have been issued for the products.

1. Handling of Unused Pins

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the

manual.

%, The input pins of CMOS products are generally in the high-impedance state. In operation with an
unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false
recognition of the pin state as an input signal become possible. Unused pins should be handled as
described under Handling of Unused Pins in the manual.

2. Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

%, The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

%. The reserved addresses are provided for the possible future expansion of functions. Do not access
these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals
After applying a reset, only release the reset line after the operating clock signal has become stable.
When switching the clock signal during program execution, wait until the target clock signal has
stabilized.

% When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock signal.
Moreover, when switching to a clock signal produced with an external resonator (or by an external
oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm

that the change will not lead to problems.

% The characteristics of Microprocessing unit or Microcontroller unit products in the same group but
having a different part number may differ in terms of the internal memory capacity, layout pattern,
and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a
product with a different part number, implement a system-evaluation test for the given product.




Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Smart Configurator for RX
together with the e? studio IDE to create a working project for the RSK+ platform. It is intended for users
designing sample code on the RSK+ platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e? studio, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX65N microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX65N Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web

site.

Document Type Description Document Title Document No.

User's Manual Describes the technical details of the RSK+RX65N-2MB User’s R20UT3888EG
RSK+ hardware. Manual

Tutorial Manual Provides a guide to setting up RSK+ RSK+RX65N-2MB Tutorial R20UT3892EG
environment, running sample code and Manual
debugging programs.

Quick Start Guide Provides simple instructions to setup the RSK+RX65N-2MB Quick R20UT3893EG
RSK+ and run the first sample. Start Guide

Smart Provides a guide to code generation and RSK+RX65N-2MB Smart R20UT3894EG

Configurator importing into the e? studio IDE. Configurator Tutorial Manual

Tutorial

Schematics Full detail circuit schematics of the RSK+. RSK+RX65N-2MB R20UT3887EG

Schematics

Hardware Manual Provides technical details of the RX65N RX65N Group, RX651 Group | RO1UHO0590EJ

microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
DVD Digital Versatile Disc
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Prmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Real Time Clock
SAU Serial Array Unit
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TAU Timer Array Unit
TFT Thin Film Transistor
TPU Timer Pulse Unit
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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RSK+RX65N-2MB R20UT3894EG0100
Rev. 1.00
RENESAS STARTER KIT+ May 31, 2017

1. Overview

1.1  Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio
IDE Smart Configurator plug-in to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:
« Project Creation with e2 studio.

« Code generation using the Smart Configurator plug-in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT3894EG0100 Rev. 1.00 R nNS Page 8 of 66
May 31, 2017 ENES



RSK+RX65N-2MB 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator plug-in for the RX
family together with the e? studio IDE to create a working project for the RSK+ platform. The tutorials help
explain the following:

e Project generation using e? studio

¢ Detailed use of the Smart Configurator plug-in for e? studio
e Integration with custom code

e Building the project in 2 studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and ‘Outputs debugging information’
option not selected, producing code suitable for release in a product.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more

in-depth information.

R20UT3894EG0100 Rev. 1.00 R nNS Page 9 of 66
May 31, 2017 ENES




RSK+RX65N-2MB 3. Project Creation with e? studio

3. Project Creation with e? studio

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX65N
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific source, project and debug files.

3.2 Creating the Project

e Start e? studio and select a suitable 2| Eplamr
location for the project workspace. Select a directory as workspace

e2 studio uses the workspace directory to store its preferences and development artifacts,

Workspace: | (SINWEIGEEIS ~ Browse...

Use this as the default and do not ask again
Ou: ag
» Recent Workspaces

e

e In the Welcome page, click ‘Create a new | Ei&

File Edit Source Refactor Navigate Search Project RenesasViews Run Target Window Help

. , B =
C/C++ pro]ect X | (o Hep @ Welcome 53 iy s &
e}
Fll enesas Welcome to €2 studio ®
1 orkbench
Get an overview of the features
Import existing &= studio projects from the filesystem or Go through tutorials

archive

Try out the samples
Review the IDE's most fiercely contested preferences v P!

Find out what is new
Open a file from the filesystem

1 Atways show Welcome at stat up

5]

¢ In the ‘Templates for New C/C++ Project’ PE New C/C++ Project
dialog, selecting ‘Renesas RX -> i
‘Renesas CC-RX C/C++ Executable | | Templates for New C/C- Project
Project’.
e Click ‘Next'. Al

Renesas Debug

GCC for Renesas RX C/C++ Executable Project
ex A C/C++ Executable Project for Renesas RX
using the GCC for Renesas RX Toolchain,

GCC for Renesas RX C/C++ Library Project
ax A C/C++ Library Project for Renesas RX using

the GCC for Renesas BX Toolchain.

Renesas CC-RX C/C++ Executable Project

‘ ax A C/C++ Project for Renesas RX using the
Renesas CCRX toolchain,

Renesas RX

Renesas CC-RX C/C++ Library Project
ax A C/C++ Library Project for Renesas RX using
the Renesas CCRX toolchain,

® < Back MNext > Finish Cancel

R20UT3894EG0100 Rev. 1.00 RENESAS Page 10 of 66
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RSK+RX65N-2MB 3. Project Creation with e? studio

e Enter the project name ‘SC_Tutorial. | EN

Click ‘Next’ New Renesas CC-RX Executable Project —
Mew Renesas CC-RX Executable Project |

Preject name: |SC_Tutorial|

Use default location
Location; C:¥Workspace¥SC_Tutorial Browse...
Create Directory for Project

Choose file system: |default

Working sets
[ Add project to working sets New...
Working sets: Select...

@ Bk ot Cocel

e In the ‘Select toolchain, device & debug | ENEEEE—EE
settings’ dialog, select the options as | | NewRenesas CCRX Executable Project =4
. . Select teolchain, device & debug settings
shown in the screenshot opposite. e
e In ‘Toolchains’ choose ‘Renesas CCRX || oo™ ..
Toolchain’. Toolchain: [Renesas CCRX -

e The RS5F565NEDXFC MCU is found | “=e
under RX600 -> RX65N -> Device Settings Configurations

: Target Device: | RSFSGSNEDRFC Create Hardware Debug Configuration
RX65N - 176 pn. Unlock Devices... E2 Lite (RX) ~
. Click ‘Next’. Endian: (IS “ [ Create Debug Configuration

Project Type: Default RX Simulator v

Create Release Configuration

e Inthe ‘Select Coding Assistant Tool’ dialog,
select ‘Smart Configurator’. New Renesas CC-RX Executable Project <

Select Coding Assistant settings |
e Click ‘Next'. '

Use Peripheral Code Generator ©

Use FIT Module Downlead FIT Modules

Smart Configurator is a single User Interface that combines the functionalities of Code Generator and FIT Configurator which imports,
onfigures and generates different types of drivers and middleware modules.

Smart Configurater encompasses unified clock configuration view, interrupt configuration view and pin configuratien view:

Hardware resources conflict in peripheral modules, interrupts and pins accurred in different types of drivers and middleware modules
ill be notified.

(Smart Configurator is available only for the supported devices)

User Application

Driver and Middleware

Driver Code FIT Modules
Configured in GUI Selected in GUI
and Generated and Imported

MCU Hardware

LLaE B ERRRRRRERERREREREDRD:)

J0184n81jUOD) HEewS

R20UT3894EG0100 Rev. 1.00 RENESAS Page 11 of 66
May 31, 2017



RSK+RX65N-2MB 3. Project Creation with e? studio

e Click ‘Next’ s o x|

New Renesas CC-RX Executable Project p—
|

Settings The Contents of Files to be Generated

What kind of initialization routine would you like to create?

[JUse /O Library
Mumber of 170 Streams:

20 o

@ < Back Finish Cancel

e A summary dialog will appear, click | ENIEEEEEC e

‘Finish’  to  complete  the  project | |NewRenesss CCRX Exacutable Project [
. Summary of project "SC_Tutorial” |
generation. ,

TOOLCHAIN NAME : Renesas CCRX
TOOLCHAIN VERSION:  v2.07.00

GENERATION FILES:

@ ......... A — o

e You may be prompted to open the Smart B Open Associated Perspective?
Conflgurator perspeCtlve- CIICk ‘Yes, to 4C%  This kind of project is associated with the C/C+~ perspective. Do you want tc cpen
open the Smart Configurator perspective. (B e

k. * 4

[[]Remember my decision
Yes No

e Wait for file generation to start. Progress Information

@O Smart Configurator operation in progress

k. * 4

Preparing startup code...

Cancel

R20UT3894EG0100 Rev. 1.00 RENESANAS Page 12 of 66
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RSK+RX65N-2MB 4. Smart Configurator Using the e2 studio plug-in

4. Smart Configurator Using the e? studio plug-in

4.1 Introduction

The Smart Configurator plug-in for the RX65N has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plug-in tool for generating template ‘C’ source code and
project settings for the RX65N. When using Smart Configurator, it supports user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
Thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code
modules for each specific MCU feature selected, general folder, r_bsp folder, r_config folder and r_pincfg
folder. These code modules are name ‘Config_xxx.h’, ‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is
an acronym for the relevant MCU feature, for example ‘CMT’. Within these code modules, the user is then
free to add custom code to meet their specific requirement. Custom code should be added, whenever
possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

By following the steps detailed in this Tutorial, the user will generate an e? studio project called SC_Tutorial.
The fully completed Tutorial project is contained on the RSK Web Installer
(https://www.renesas.com/rskrx65n2mb/install) and may be imported into e? studio by following the steps in
the Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for e? studio.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK+.

Following a tour of the key user interface features of Smart Configurator in ‘Clocks configuration page’,
‘Components page’, ‘Pins configuration page’ and ‘Building the Project’, the reader is guided through each of
the peripheral function configuration pages, familiarised with the structure of the template code, and adding
their own code to the user code areas provided by the Smart Configurator.

The Smart Configurator installer is contained on the RSK Web Installer. This installer must be run before
proceeding to the next section.

R20UT3894EG0100 Rev. 1.00 RENESAS Page 13 of 66
May 31, 2017
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RSK+RX65N-2MB 4. Smart Configurator Using the e2 studio plug-in

4.2 Project Configuration using Smart Configurator - Overview page

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the Smart Configurator User Guide.
You can download the latest document from: https://www.renesas.com/smart-configurator.

From the e? studio menus, select ‘Window -> Perspective -> Open Perspective -> Other. In the ‘Open
Perspective’ dialog shown in Figure 4-1, select ‘Smart Configurator’ and click ‘OK’.

P8 Open Perspective

HEIC/C++ (default)
m:”sICnde Generator
7'QL.‘QSADebug

%JJava

E;"\JJEVE Browsing

ngJava Type Hierarchy
EfRemote System Explorer
{5 Resource

= Scripting

g
ﬁ:Target Explorer
éuTeam Synchrenizing

%Tracing

Figure 4-1 Open Perspective Dialog

The Smart Configurator initial view is displayed as illustrated in Figure 4-2.

dio

45 Debug  |[E sc_tutorisl HardwareDebug v - | B~ R~ B G0~ % 0D QS8 E S Qi i Gl v m oD
[y Project Explorer 2 E % Y= O §SClutoralsfg 52 = B % MCUPackage X =8
v 5 Titoral o 5 = o[ @
S inciudes Overview information SR ERERIE
v @B ~ General Information ®

This

editor allows you to modify the settings stored in configuration file (:scfg)

Board
Allow board and device selection

# SCTutoralscia

Application under

Clocks evelopment

Allow clock configuration ~Comparents
| Middieware |

Components Device

Allow software component selection and configuration driver ‘ oS ‘

e < s

Pins

Allow general pin configuration and pin configuration for selected software component

Interrupt
Allow genera! and for selected

= RENESAS

~ Current Configuration

RX65N
Selected board/device: RSFSSSNEDXFC
Selected components: ST
Component Configurstion
@ rbp bsplused)
< > | Overview| Board | locks | Componen] Pins| Interrupt > Legend
& Console 2 Bl | @ By = 0O [ Configuration Problems 52 ~e=g
Smart Configurator Qutput Qitemns
1M06600002: File generated:src\smc_gen\r_config\r_bsp_interrupt_config.h A Description - Trpe
1106000002 File generated :src\sme_gen\r_confighr_bsp_ir

riority_cfg.h

Oitems selected

IS N ¢ 10)

Figure 4-2 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured e? studio project that builds and runs without error.
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RSK+RX65N-2MB 4. Smart Configurator Using the e2 studio plug-in

4.3 Clocks configuration page

Clocks configuration page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
r_bsp_config.h file in \src\smc_gen\r_config.

4.3.1  Clocks configuration

Figure 4-3 shows a screenshot of Smart Configurator with the Clocks tab. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-3.

% =SC_Tutorial.scfy 34 -
Clocks configuration IOR=]

PLL circuit

SCKCR (FCLK[3:0T) FlashlF clock (FCLK)
Frequency Division:
x4 - oo (MHz)
x1 -
SCKCR (ICLK[3:0) N 1CLK)
¥ Main clock Frequency Multiplication: " N System clock \ICLK:
Oscillation source: | Resonator - ©10.0 - p— * 1200 (ChE
requency: | 24 M) ] COTH O USIRELT Peripheral module ciock (PCLKA)
o a2~ 000000 |10 (MHz)
Oscillation wait time: - o
SCKCR (PCLKB[3:0]) Peripheral module clack (PCLKB)
(us) actual value: 30848485 us
| o x174 e —— ) (MHz)
SCLERIBGELC:TY Peripheral module dock (PCLKC)
g X4 - 0 (MHz)
P SCKCR (PCLKD{3:0) Peripheral module clock (PCLKD)
ub-clod X174 b —r %) (MHZ)
1 SCHCR (BCK[3:0D) External bus clack (BCLK)
X172 T 1200 (MHz)
BCKCR (BCLKDIV)
- [
HOCO clock SO (LHTE]) USE clock {UCLK)
L x1/5 o —— %)) (MHz)
LOCO clack
CANMCLK/CACMCLK
24 (MHz)
Overview | Board Component Pins| Interrupt
Figure 4-3 Clocks Configuration page
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4.4  Components page

Drivers and middleware are handled as software components in Smart Configurator. The Components page

allows user to select and configure software components.
84 *SC_Tutonial.scfg 52

Software component configuration

Components = ;.é:p -

%

type filter text

~ [= Startup
v [= Generic
.E r_bsp
(= Drivers
= Middleware
= Application

Owverview | Board CIucksPins Interrupt

Figure 4-4 Components page

441  Add asoftware component into the project
Smart Configurator supports two types of software components: Code Generator and Firmware Integration

Technology. In the following sub-sections, the reader is guided through the steps to configure the MCU for a
simple project containing interrupts for switch inputs, timers, ADC and a SCI by component of Code Generator.

Click ‘Add component’ & icon.

{8 SC_Tutorial.scfg 33
Software component configuration

Components =] 2 - Configure

&

type filter text

v [= Startup
w [ Generic
& rbsp
= Drivers
= Middleware
= Application

Figure 4-5 Add a Code Generator component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator'.

P New Co mponent

Software Component Selection
Select compenent from those available in list 1jj
Function |All ~
Type All ~
. All
Filter Firmware Integration Technolog
Component Type Version 2
E 2-Bit Timer Code Generator 1.0.0
B Clock Frequency Accuracy Mea... Code Generator 1.0.0
E{Zompare Match Timer Code Generator 1.1.1

Figure 4-6 Add a Code Generator component (2)
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4. Smart Configurator Using the e2 studio plug-in

442 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.

Select ‘Compare Match Timer’ as shown in Figure 4-7 below then click ‘Next'.

P8 New Component

Software Component Selection

Select compenent from these available in list $
Function All v
Type 9 Code Generator ~
Fiter |

Component - Type Version K

8 8-Bit Timer Code Generator 1.00

#8 Clock Frequency Accuracy Mea... Code Generator 1.00

# Compare Match Timer Code Generator 1.1.1 |

8 Complementary PWM Mode Ti..  Code Generator 1.1.0

# CRC Calculator Code Generator 1.00

8 D/A Converter Code Generator 1.00

# Data Operation Circuit Code Generator 1.00

#8 Data Transfer Controller Code Generator 1.00

# DMA Controller Code Generator 110

# Event Link Controller Code Generator 1.00

M _coo_ba_a_canan P ann e

< >
Show only last version
Description

This software component provides configurations for 16-bit/32-bit timer with module

CMT/CMTW and can generate interrupts at set intervals,

Download more software components

@ <Back [ Mea> [ _Ensh || Cancel

Figure 4-7 Select Compare Match Timer

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTOQ’ as shown in Figure 4-8

below then click ‘Finish’.

ﬁ New Component

Compare Match Timer
Configuration name: Config_CMTO ‘
Resource: CMTO ~

Figure 4-8 Select Resource - CMTO
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4. Smart

Configurator Using the e2 studio plug-in

In the ‘Config_CMTOQ’ configures CMTO as shown in Figure 4-9. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

8% *SC_Tutorial.scfg 53

Software component configuration

Components =] E Configure
&= Count clock setting
- (® PCLK/S (O PCLK/32 (O PCLK/128 O PCLK/512
type filter text
Compare match setting
v [= Startup
v (= Generic Interval value I‘I I | ms ~ | (Actual value: 1.000000)
& rbsp Register value (CMCOR) 7499 |
w [= Drivers
v = Timers Enable compare match interrupt (CMIO)
& Config CMTO Priority |§Leue| 10 v|
[= Middleware

Figure 4-9 Config_CMTO settin

g

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-10 below then click ‘Finish’.

PR New Component

Add new configuration for selected component

Compare Match Timer

Configuration name: | Config_CMT1

Resource: I%CMT] ~
@ < Back Next > Cancel

Figure 4-10 Select Resource — CM

T1

Navigate to the ‘Config_ CMT1’ and configure CMT1 as shown in Figure 4-11. This timer is configured to
generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.

Components = ::: -  Configure
%o Count clock setting
- (O PCLK/S (@ PCLE/32 (O PCLK/128 (O PCLK/512
type filter text
s Compare match setting
v tartup
v (= Generic Interval value IED I I ms ~ [ {Actual value: 20,000000)
@ rbsp Register value (CMCOR) [37490 |
v [= Drivers
v = Timers Enable compare match interrupt (CMIT)
.r Config_CMTO Briority |Leve|10 vI
& Config CMT1

Figure 4-11 Config_CMTL1 setting
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4. Smart Configurator Using the e2 studio plug-in

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-12 below then click ‘Finish’.

PR Mew Component

Add new configuration for selected p t tlj-
Compare Match Timer
Configuration name: | Config_CMT2 |
Resource: I?CMTZ w I
® < Back Next > Cancel
Figure 4-12 Select Resource — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-13. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in

this tutorial.

48t =SC_Tutorial.scfg 52

Components

.

type filter text

Software component configuration

S A

v [= Startup
W [= Generic
& rbsp
w [= Drivers
w = Timers
& Config_CMT2
& Config_CMTO
& Config_CMT1

Configure

Count clock setting

(O PCLE/S (O PCLK/32 (O PCLK/128

Compare match setting

Interval value |2[)0 I I ms ~ I[Ac‘.ual wvalue: 200,004267)
Register value (CMCOR) [22437 |

Enable compare match interrupt (CMI2)

Pricrity IELE\JEI 10 iV I

Figure 4-13 Config_CMT2 setting
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4. Smart Configurator Using the e2 studio plug-in

4.4.3 Interrupt Controller

Referring to the RSK+ schematic, SW1 is connected to IRQ11(P03) and SW2 is connected to IRQ13 (P05).
SW3 is connected IRQ15(P07) and the ADTRGON. Tutorial used ADTRGONn and will be configured later in

§4.4.7.

Click ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.
Select ‘Interrupt Controller’ as shown in Figure 4-14 then click ‘Next'.

Software Component Selection tlj-

Select component from those available in list

Function |All ~
Type 1 Code Generator ~ I
Filter ‘ |

Component : Type Versicn @

B8 12C Master Mode Code Generator 1.0.0

B 12C Slave Mode Code Generator 1.00

H Interrupt Controller Code Generator 1.20 |

8 Low Power Consumption Code Generator 1.1.0

H# Normal Mode Timer Code Generator 1.0.0

B Phase Counting Mode Timer Code Generator 120

8 Port Output Enable Code Generator 1.00

B Ports Code Generator 120

-5} Programmable Pulse Generator ~ Code Generator 1.00

HE PWM Mode Timer Code Generator 1.1.0

= SR TRNE S P P Py 1N
<

Show enly last version

Description

Interrupt Controller configures the interrupt requests generated by ICU: Software
interrupt, NMI pin interrupt and IRQ External pin interrupts.

Download more software components

@ < Back I Next > I I Einish I Cancel

Figure 4-14 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-15

below then click ‘Finish’.

E New Component

Add new configuration for selected component |

Interrupt Controller

Configuration name: Config_ICU |

Resource: acy HRY

® < Back Next > Cancel

Figure 4-15 Select Resource — ICU
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Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-16

below.

{8k *SC_Tutorial.scfg 52
Software component configuration

Components =] :%:9 -

L

type filter text

v (& Startup
w [= Generic
f r_bsp
~ [= Drivers
v (= Interrupt
& Config_ICU
v [= Timers
@ Config_CMT2
& Cenfig CMT0
& Config CMTI
= Middleware
(= Application

Configure

Software interrupt setting
[ Software interrupt

[ Software interrupt 2

MM pin interrupt setting
[CINMI pin interrupt

IRQO setting
CJirRao

IRQ1 setting
Oira

IRQ2 setting
Ora2

IRQ2 setting
ira2

IRQ4 setting
Oirg4

IRQS setting
JIrRas

IRQE setting
Oiras

IRQ setting
oy

IRQ8 setting
iras

IRQ9 setting
irae

IRQ10 setting
iraio

IRQ11 setting

IRQ12 setting
Cirai2

IRQ13 sefting

IRQ14 setting
CJIRQ14

IRQ15 setting
Cirats
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Falling edge

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level
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Low level
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Low level
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Low level
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Low level
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Low level
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Low level
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Low level
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Detection type | Falling edge ~ Digital filter

Priority

Detection type | Falling edge ~

Priority

Level 15 (highest) ~

Low level

Level 15 (highest)

Level 15 (highest) ~

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Digital filter

Mo filter

Mo filter

No filter

Mo filter

Mo filter

No filter

Mo filter

No filter

Mo filter

No filter
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Mo filter

No filter

Mo filter

Mo filter
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Figure 4-16 Config_ICU setting
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4. Smart Configurator Using the e2 studio plug-in

4.4.4 Ports

Referring to the RSK+ schematic, LEDO is connected to P73, LED1 is connected to PG7, LED2 is connected
to PG6 and LED3 is connected to PG5. PJ3 is used as one of the LCD control lines, together with PF5, PG3

and PG4.

Click ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.
Select ‘Ports’ as shown in Figure 4-17 then click ‘Next'.

PR New Component

Software Component Selection -Ha-

Select component from those available in list

Function | All ~
Type 1 Code Generator ~ I
Filter | |

Component Type Version 2

H# Low Power Consumption Code Generator 110

H# Normal Mode Timer Code Generator 1.00

## Phase Counting Mode Timer Code Generator 1.20

£ Port Output Enable Code Generator 1.0.0

Ports Lode Generator 1.20 |

# Programmable Pulse Generator  Code Generator 1.00

B PWM Mode Timer Code Generator 110

H# Real Time Clock Code Generator 1.00

R SCI/SCIF Asynchronous Mode Code Generator 1.00 v

< >

Show only last version

Description

This software component provides configurations for General Purpose Input/Output.
Commoen features such as reading, writing, and setting the direction of ports and pins
can be configured. Enabling features such as open-drain outputs and internal pull-
ups are also supported.

Download more software components

® < Back I Mext > I | Einish | Cancel

Figure 4-17 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-18

below then click ‘Finish’.

PS New Component

Add new configuration for selected component -E-
Ports
Configuration name: Config_PORT |
Resource: PORT P

Figure 4-18 Select Resource — PORT
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‘PORT7’, ‘PORTF, '‘PORTG’, ‘PORTJ' tick box is checked as shown in Figure 4-19 below.

{8 ~SC_Tutorial.scfg 52

Software component configuration

[C1PORT1
[]1PORT2
[1PORTS
[ PORTS
] PORTE
[ PORTD

PORTE

Components =] :..;:9 »  Configure
% Port selection
type filter text
v (= Startup CJPORTO
w = Generic
@& rbsp CIPORT2
w [ Drivers
v = Interrupt CIroRT4
& Config_ICU
v = /O Ports C1PORTE
& Config_PORT
w = Timers []rORTE
& Config_CMT1
@ Config_CMT2 C]PORTA
& Config_CMTO
= Middleware [JroRTC
= Applicaticn
C1PORTE
I 1PORTG |

[=

PORTY PORTF PORTG PORTJ

Figure 4-19 Select Port selection

Navigate to the ‘Ports’ configure these four 1/O lines and LCD control lines as shown in Figure 4-20, Figure
4-21, Figure 4-22 and Figure 4-23 below. Ensure that the ‘Output 1’ tick box is checked, except PG3. Select

‘PORT7’ tab.

8% *5C_Tutorial.scfg 53

Software component configuration

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output

CMOS output
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type filter text
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w [ Generic Unused In Out Pull-up
& rbsp
~ 2= Drivers P70
Int it
e B‘:.eg:':;lg iU ®Unused Oin O0Out Pull-up
v [= /0 Ports
& Config_PORT Pl
w (= Timers ®Unused OlIn O 0ut Pull-up
& Config CMT1
-r Config_CMT2 P72
= Md:\ Contig CMTO ®Unused Olin OCut Pull-up
I eware
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== Applicaticn .
OlUnused  Oln Pull-up
P74
®Unused Olin OCut Pull-up
P75
@®Unused Oln O 0ut Pull-up
P76
®Unused Olin O0ut Pull-up
P77
@®Unused Olin O0ut Pull-up

CMOS output

Output 1

Output 1

Output 1
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Output 1
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Figure 4-20 Select PORTY7 tab
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Select ‘PORTF’ tab.

8 *SC_Tutorial.scfg 52 = 08
Software component configuration al &
Components laz =] }:g; ~  Configure Ll
%= = Port selection PORW-PORTG PORT)
type filter text
v [= Startup [ apply to all
w [ Generic Unused In Out Pull-up CMOS output Output 1
& rbsp
~ [= Drivers PEO
Int it
ve .;'eg:rf;\g_lcu @ Unused Oln O0ut Pull-up  |CMOS output Output 1
v [= /O Ports
& Config_PORT P
v (= Timers @ Unused Oln O O0ut Pull-up  [CMOS output Output 1
& Config_CMT1
& Config_CMT2 PE2
"-. Config CMTO ®Unused  Oln () 0ut Pull-up CMOS Qutput 1
- tput Output
& Middleware ° 2o P
Applicat
= Application pez
@ Unused  Oln (C0ut Pull-up CMOS output Output 1
PF4
@ Unused  Oln (C0ut Pull-up CMOS output Output 1
PF5
() Unused Pull-up | CMOS output W

Figure 4-21 Select PORTF tab

Select ‘PORTG' tab.

8 *SC_Tutorialscfg 52 = 0
Software component configuration o &
Components L= 2. Configure =
% = Port selection  PORTY PORTFPORTJ
type filter text
v (= Startup DApp\ytDaH
w [= Generic Unused In Out Pull-up CMOS output Output 1 Normal drive output
& rbsp
~ [ Drivers PGO
v & Intermpt @Unused Ol OOut | Pull-up  |CMOS ourput Output 1 [Normsl drive sutput
& Config ICU nust n u ull-up outpu Output ormal drive outpu
v = /O Poris
~ o PG1
o Config_PORT
w = Timers @ Unused OlIn O 0ut Pull-up CMOS output Output 1 Normal drive output
& Config_CMT1
& Config CMT2 pG2
. @& (Config CMTO @ Unused OlIn O0ut Pull-up CMOS output Output 1 High-drive output
= Middleware
Applicati
= Application PG3
() Unused Pull-up CMOS output ~| [JOutput1 | High-drive cutput ~
PG4
() Unused Pull-up CMOS output ~ High-drive output ~
PGS
O Unused Pull-up  |CMOS output ~ High-drive output v
PGE
() Unused Pull-up CMOS output ~ High-drive output ~
PGT
O Unused Pull-up  |CMOS output ~ High-drive output v
Figure 4-22 Select PORTG tab
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Select ‘PORTJ’ tab.

8k *5C Tutorial.scfg 51
Software component configuration

Components az =l :% +  Configure

% = Port selection  PORT7 PORTF PORTG| PORT

%l g

type filter text
v & Stariup CJapply to all
v [= Generic Unused In Out Pull-up CMOS output Cutput 1
& rbsp
w [= Drivers PI0
v & Interrupt @Unused Oln OOut [ Pullup  |CMOS Output 1 |Normal dri
*._ Config_ICU nus: n u ull-up output Output ormal drive output
v = |/OPorts
&+ Config_PORT P
v (= Timers @Unused Oin Oout Pull-up CMOS output Output 1 Normal drive output
& Config CMT1
& Config CMT2 Iz
i & Config CMTO @®Unused Olin (O0ut Pull-up  |CMOS output Output1  |Normal drive output
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Application
(= Appl e
OUnused  Oln Pull-up CMOS output
RJ5
@Unused Oln J0Out Pull-up CMOS output Output 1
Figure 4-23 Select PORTJ tab
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4.45  SCI/SCIF Asynchronous Mode

In the RSK+RX65N-2MB SCI8 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as

shown in the schematic.

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’.
Select ‘SCI/SCIF Asynchronous Mode’ as shown in Figure 4-24 then click ‘Next'.

PR New Component

Software Component Selection -E-

Select compoenent from these available in list

Function | All w
Type 1 Code Generator ~ I
Filter | |
s
Component Type Versicn &
HE PWM Mode Timer Code Generator 1.1.0
H2 Real Time Clock Code Generator 1.0.0
HH SCI/SCIF Asynchronous Mode LCode Generator 1.0.0 |
8 SCI/SCIF Clock Synchronous M...  Code Generator 1.00
£ Single Scan Mode S12AD Code Generator 1.1.0
H 5PI Clock Synchrenous Mode Code Generator 1.00
2 SPI Operation Mode Code Generator 1.00
B Vnltana Netartinn Circoit e Generatnr inn &7
£ >
Show only last version
Description
This software compenent provides configurations for SCI(SCIF) single(multi-
processor) asynchronous mode.
Download more software components
@ < Back I Next = Il Finizh | Cancel

Figure 4-24 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as
shown in Figure 4-25 below.

P& New Component

Add new configuration for selected component -E-
SCI/SCIF Asynchronous Mede
Configuration name: Config_5CI0 |
Work mode: Multi-processor Reception ~
Resource: Multi-processor Reception

Multi-processor Transmission
Multi-precessor Transmissicn/Reception
Reception

3 [
Transmission/Reception

® < Back MNext = Cancel

Figure 4-25 Select Work mode — Transmission/Reception
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In ‘Resource’, select ‘SCI8’ as shown in Figure 4-26 below.

PR Mew Component

Add new configuration for selected component

SCI/SCIF Asynchronous Mode

Configuration name: Config_SCI0

Work mode: Transmission/Reception

Resource: sCie

SCI0
sci
sCho
sCim
sChnz2
SCi2
sCI3
SCi4
5CI5
5CI6
SCIT

sCI9

@ < Back Next >

o

Figure 4-26 Select Resource — SCI8

Ensure that the ‘Configuration name’ updates to ‘Config_SCI8' as shown in Figure 4-27 below then click

‘Finish’

P8 New Component

Add new configuration for selected component -E-
SCI/SCIF Asynchronous Mode
Configuration name: ICunﬁg_SCIS I
Work mode: Transmission/Reception w
Resource: 5CI8 ~

Figure 4-27 Ensure Configuration name - Config_SCI8
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Configure SCI8 as shown in Figure 4-28. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD8 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.
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Interrupt setting

TXI8 priority

RXI8 priority

Enable reception error interrupt (ERIS)

TEIB, ERIB prioity (Group BLT)

Callback function setting
[ Transmission end

(®) 8 bits

(CEven

(O 2 bits

() MSB-first

Internal clock

16 cycles for 1-bit period

(7 bits

O 0dd

VI (bps) (Actual value: 19230.768, Error: 0.160%)

| 19200

SCK is not used ~

Clock signal divided by 1 0000000
OcTssz QO RTSE

Data handled in interrupt service routine ~

Data handled in interrupt service routine ~

Lewvel 15 (highest) v

Level 15 (highest) v

w

Level 15 (highest)

Reception end

Reception error

Figure 4-28 Config_SCI8 setting
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4.4.6  SPIClock Synchronous Mode

In the RSK+RX65N-2MB SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as

shown in the schematic. Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type,
select ‘Code Generator’. Select ‘SPI Clock Synchronous Mode’ as shown in Figure 4-29 then click ‘Next’.

PR New Component

Software Component Selection -E-

Select compoenent from these available in list

Function | All ~
Type 1 Code Generator ~ I
Filter | |
Component Type Versicn &
H Programmable Pulse Generator  Code Generator 1.00
B8 PWM Mode Timer Code Generator 1.1.0
8 Real Time Clock Code Generator 1.00
B 5CI/SCIF Asynchronous Mode Code Generator 1.00
7 5CI/SCIF Clock Synchronous M. Code Generator 1.00
#2 Single Scan Mode 512AD Code Generator 1.1.0
4 SPI Clock Synchronous Mode Code Generator 1.0.0 |
#8 5Pl Operation Mode Code Generator 1.00
B Voltage Detection Circuit Code Generator 1.0.0 A
£ >
Show only last version
Description
This component provides clock synchronous operation of RSPI or 5CI (Simple SPI
bus). It includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master
transmit/receive and Master transmit.

Download more software components

® < Back I Mext > I | Finish | Cancel

Figure 4-29 Select SPI Clock Synchronous Mode

Ensure Operation, select ‘Master transmit only’ as shown in Figure 4-30 below.
PR Mew Component

Add new configuration for selected component -E-

SPI Clock Synchronous Mode

Configuration name: | Config_RSPI0 |

Operation: Master transmit only w

Slave transmit/receive
Resource: Slave transmit only
IMaster transmit/receive

® < Back Mext = Cancel

Figure 4-30 Select Operation — Master transmit only
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In ‘Resource’, select ‘SCI6’ as shown in Figure 4-31 below.

PR Mew Component

Add new configuration for selected component -E-

SPI Clock Synchronous Mode

Configuration name: Config_RSPI0 |

Operation: Master transmit only ~

Resource: RSPIO v

RSPIO
RSPIT
RSPI2
SCio
scn
sCio
sCi1
sChnz2
sCi2
sCI3
SCi4

£

SCis

@ <BsCI9

Figure 4-31 Select Resource — SCI6

Ensure that the ‘Configuration name’ updates to ‘Config_SCI6’ as shown in Figure 4-32 below then click

‘Finish’

PR Mew Component

Add new configuration for selected component -E-

SPI Clock Synchronous Mode

Configuration name: ICunﬁg_SCIS I
Operaticn: Master transmit only ~
Resource: 5CI6 v

Figure 4-32 Ensure Configuration name - Config_SCI6
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Configure SCI6 as shown in Figure 4-33. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 15000 kbps. All other settings remain at their defaults.
{8k *SC_Tutorial.scfg 53

Software component configuration

Components = T Configure
- Transfer direction setting
W %
- () LSB-first (®) MSB-first
type filter text
v [= Startup Data inversion setting
v = aneric (® Normal (O Inverted
& rbsp
v [= Drivers Transfer speed sefting
v [ Interrupt
& Config_IcU Transfer clock Internal clock (SCK6 pin functions as clock output pin) v
vE |l,.f[) Ports Bit rate (kbps)  (Actual value: 15000, Error: 0%)
& Config_PORT
v [ Communications []Enable modulation duty correction
& Config_SCI6 i
& Config_SCI& Clock setting
v [= Timers [JEnable clock delay [JEnable clock polarity inversion
& Config_CMT1
& Config_CMT2 Data handling setting
@ Config_CMTO ) ) — X - >
= Middleware Transmit data handling Data handled in interrupt service routine
Applicati
& Application Interrupt setting
TXI6 pricrity Level 15 (highest) ~
TEIE priority (Group BLO) Level 15 (highest) ~
Callback functicn setting
Transmission end
Figure 4-33 Config_SCI6 setting
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4477  Single Scan Mode S12AD

We will be using the S12AD on Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click

‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Code Generator’. Select

‘Single Scan Mode S12AD’

as shown in Figure 4-34 then click ‘Next'.

PR Mew Component

Software Component Selection -E-

Select compenent frem those available in list

Function | All ~
Type 1 Code Generator ~ I
Filter | |
Component Type Version &
H# Programmable Pulse Generator  Code Generator 1.00
B2 PWM Mode Timer Code Generator 1.1.0
£ Real Time Clock Code Generator 1.00
H 5CI/SCIF Asynchronous Mode Code Generator 1.00
7 SCI/SCIF Clock Synchronous M...  Code Generator 1.0.0
£ Single Scan Mode 512AD Code Generator 1.1.0 |
#7 SPI Clock Synchronous Mode Code Generator 1.00
£ 5Pl Operation Mode Code Generator 1.00 v
£ >
Show only last version
Description
This software component provides single scan mode configurations for 12-Bit A/D
Converter which the analeg inputs of up to & (unit 0) and 21 (unit 1) channels
arbitrarily selected are converted for only once in ascending channel order.

Download more software compenents

® < Back I MNext = Il Einish | Cancel

Figure 4-34 Select Single Scan Mode S12AD

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘S12AD0’ as shown in Figure
4-35 below then click ‘Finish’.

PR Mew Component

Add new configuration for selected component -E-

Single 5can Mode 512AD
Configuration name: |tonfig_51 2AD0 |

Resource: S12AD0 hdl

® < Back Next » Cancel

Figure 4-35 Select Resource — S12AD0
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Configure S12ADO0 as shown in Figure 4-36 and Figure 4-37. Ensure the ‘Analog input channel’ tick box for
ANOO0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings
remain at their defaults.

{9:3 *5C_Tutorial.scfg &3
Software component configuration
Components = :'..=:;> ~  Configure
B W + Basic setting
type filter text Analog input mode setting
v (& Startup [ Double trigger mode
~ [ Generic . .
~ Analog input channel setting
W rbsp
v [ Drivers A4 ANDOD C1ANDO1 [JANDO2 C1ANDO3 [ ANDO4
v [= Interrupt [] AmDOS ] ANDDE [JaNoo7
& Config_ICU
v (&= /O Ports Conversion start trigger setting
& Config PORT Start trigger source
~ [=- Communications
& Config_SCIE I A/D conversion start trigger pin ~ I
& Config_SCI8
w (= A/D Converter Interrupt setting
W Config_S12AD0 Enable AD conversion end interrupt (S12ADI) Priority | Level 15 (highest) v
w = Timers
& Config CMT1 .
- & g
& Config_CMT2 = 2
& Config_CMTO Add/Average AD value setting
& ‘T'dﬁ‘e":_a'e [ AN000 ANOOT ANOD3 ANOD4
& Application ANDOS ANOOG
Self diagnosis setting
Mode Unused ~
ov
Disconnection detection assist setting
Charge setting Unused ~
2 ADCLK
Dedicated sample held circuit channel setting
[ ANDOO ANOOT AMNOO2
Data registers setting
Data placement Right-alignment ~
Automatic clearing Disable automatic cleaning ~
Conversien resolution 12-bit accuracy ~
Addition/Average mode select Addition mode ~
Addition count 1-time ~
Window function setting
(®) Disable () Enable
Figure 4-36 Config_S12ADO setting (1)
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Window A/B operation setting

[ Enable comparisen window A

Window A/ complex condition

A/D comparisen A setting

Reference data 0 for comparizan

Reference data 1 for comparison

Use comparator for ANODO

Use comparator for ANOOT

Use comparator for ANOOZ

Use comparator for ANDO2

Use comparator for ANO0S

Use comparator for ANODS

Use comparator for ANODG

Use comparator for ANODT

A/D comparison B setting

Reference data Ofor comparison

Reference data 1 for comparison

Cormparison B channel

Input sampling time setting

Dedicated sample and hold circuit

ANO0O/Self-diagnosis

AN
AN
AN
AN
ANDDE
AN
AMNT

Interrupt setting

Enable AD conversion compare interrupt A (S12CMPAI)

Group ELT priority

[]Enable comparison window B

Window A comparison condition matched OR window B comparison condition matched

]

]

Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

0
0
Unused

Reference data 0 > A/D-converted value

4 fus)
0182 | s
0.183 {us)
0.183 fus)
0183 fus)
0.183 fus)
0.183 fus)
0.183 (us)
0.183 fus)

(Total conversion time: 0.767us)

Level 15 (highest)

Enable AD conversion compare interrupt B (512CMPBI)

(Actual value; 4.00

(Actual value: 0.183)
(Actual value: 9,183
[Actual value: 8183
[Actual value: 9.183)
[Actual value: 0183
[Actual value: 8.183)
(Actual value: 9.183)
[Actual value: 8183

Figure 4-37 Config_S12ADO setting (2)

R20UT3894EG0100 Rev. 1.00
May 31, 2017

RENESAS

Page 34 of 66



RSK+RX65N-2MB

4. Smart Configurator Using the e2 studio plug-in

4.5 Pins configuration page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed using the Pins page.

{8k *SC_Tutorial.scfg 3
Pins Configuration
Hardware Resource

Type filter text

ERSE

,A‘ﬂ All

#F Clock generator
% .
&3 Clock frequency accuracy measurement circu

ﬁﬁ Buses

#F Interrupt controller unit
% Multi-function timer pulse unit 3
{%, Port cutput enable 3
v &, 16-bit timer pulse unit
w TPUO
TP
TRUZ
TPU3
TPUM4
w TPUS
~ &, Programmable pulse generator
w PPGO
w PPGI
v . B-bit timer
<

Pin Function  Pin Number

Overview | Board | Clocks Component Interrupt

Figure 4-38 Pin configuration page

45.1 Change pin assignment of a software component

To change the pin assignment of a software component in the Pin Function list, click

show by Software Components.

Software Components

i;":':; *5C_Tutorial.scfg i3

Pins Configuration

Type filter text

=/ l"‘@

Figure 4-39 Change view to show by Software Components

I

to change view to
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Select the Config_ICU of Software Components. In the Pin Function list -> Assignment column, change the
pin assignment IRQ13 to P05, IRQ11 to P0O3. Ensure the ‘Enable’ tick box of IRQ11 and IRQ13 are checked,
as shown in Figure 4-40.

48k *SC_Tutorial.scfg 33 = O
Pins Configuration GRS
Software Components Bl |&; g2 @ Pin Function =2 | =] | B3 3

Type filter text Type pin function
v ;"-": r_bsp Enabled  Function Ascignment Pin Mumber Direction Remarks
wi r_bsp O IRQO Mot assigned Mot assigned MNone
v ‘-"': Compare Match Timer O IRQ1 Mot assigned Mot assigned Nene
¢ Config_CMTO O IRQ2 Mot assigned Mot assigned Nene
u' Config_CMT1 0 IRQ2 Mot assigned Mot assigned Nene
&' Config_CMT2 | IR Mot assigned Mot assigned MNone
v -.,-".-. Interrupt Controller | IRQS Mot assigned Mot assigned MNone
O IRC6 Mot assigned Mot assigned MNone
- Pfrts | IROT Not assigned Mot assigned None
@& Config_PORT O IRCE Mot assigned Mot assigned Nene
v ‘-5‘: SEI;’SCIFAs}fnchronous Mode 0 IRQQ Not assigned Mot assigned MNone
i Config_SCI8 | IRQ10 Not assigned Not assigned None
v ‘-'": SEI Clock Synchrenous Mode IRQ11 Imnh‘DA[J |4 I
W Config_5CI6 ™ IRQ12 Mot assigned Not assigned None
v & Single Scan Mode S124D RQ13 [ pos/IRa13/DAT B |
@& Config_S12AD0 O IRCy14 Not assigned Mot assigned None
O IRQ13 Not assigned Mot assigned None
™ NMI Mot assigned Mot assigned Nene
2 >

Pin Function  Pin Number

Overview | Board | Clocks | Component | Pins | Interrupt

Figure 4-40 Configure pin assighment - Config_ICU

Select the Config_SCI8 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD8 and TXD8 are checked and Assignment column of RXD8 is PJ1 and TXD8 is PJ2
as shown in Figure 4-41.

{8 *5C_Tutorial.scfg &2 = O

Pins Configuration % &

Software Components [l |3, & | PinFunction ~) | _g;” B2 2y

Type filter text Type pin functicn

v -'f'-": r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks
W rbsp CTses Mot assigned Mot assigned Maone

RTS8# Mot assigned Mot assigned Macne

RXDS | PI1/MTIOCEA/RXDS/SMISOS/S... | 59 [

SCK& Mot assigned Not assigned MNone

TXD& | PI2/TXDE/SMOSIB/SSDAS/SSLLC. . | 58 o]

v _.‘-'": Compare Match Timer
! Config_CMTO
w! Config_CMT1
w! Config_CMT2
v & Interrupt Controller
& Config_ICU
W _-f-"': Ports
& Config_PORT
w SCI/SCIF Asynichronous Mode

[
& Config_SCI8
w 2o SPICleck Synchronous Mode

& Config_5CI6
v /% Single Scan Mode S12AD
@& Config_S12AD0

Ro”oo

Pin Function  Pin Number

Overview | Board | Clocks | Compenent | Pins | Interrupt

Figure 4-41 Configure pin assignment - Config_SCI8
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Select the Config_SCI6 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is P02, SMOSI6 is P00
as shown in Figure 4-42.
48% *SC_Tutorial.scfg 53

Pins Configuration

Software Components

Type filter text

BB %

W

W

_ﬁ r_bsp
n' r_bsp
_-F-_ Compare Match Timer
n! Config_CMTO
n! Config_CMT1
w' Config_CMT2
_ﬁ Interrupt Controller
& Config_ICU
_-,i'_ Ports
& Config_PORT
_ﬁ SCIYSCIF Asynchronous Mode
& Config_5CI8
_-[% SPI Clock Synchroncus Mode
% Single Scan Mode 512AD
& Config_S12AD0

Pin Functien  Pin Number

Pin Function

Type pin functicn

Enabled  Function
]  sse2
SCK6
O]  SsMmIsOs
SMOSIE

COwverview | Board | Clocks | Compenent | Pins | Interrupt

Figure 4-42 Configure pin assighment - Config_SCI6

Assignment

Mot assigned

Pin Mumker

Net assigned

| Poz/TMCIT/SCKE/IROT0/ANT20 | 6

Mot assigned

Mot assigned

| PoO/TMRIO TXDE/SMOSIE/SSD... | 8

Direction
Mone

le]

Mone

(o]

= 8
% &

AR s

Remarks

Select the Config_S12ADO0 of Software Components. In the Pin Function list -> Assignment column, Ensure
the ‘Enable’ tick box of ANO0OO, AVCCO, AVSSO, ADTRGO#, VREFHO and VREFLO are checked and
Assignment column of AN0OO is P40, ADTRGO# is PO7 as shown in Figure 4-43.

{8k *5C_Tutorial.scfg 52

Pins Configuration

W

W

Software Components =l laz d\%
Type filter text
_-,-"'; r_bsp
Wi r_bsp
_-[-"'; Compare Match Timer

w! Config_CMTO
w! Config_CMT1
w! Config_CMT2
_-[-"'; Interrupt Controller
& Config_ICU
_.‘-'": Ports
& Config_PORT
_v,-"'; SCIFSCIF Asynchronous Mode
& Config_SCI8
_-,-"'; SPI Clock Synchroneus Mede
& Config_SCI6
2 Single Scan Mode 512AD

i Config_512AD0

Pin Function Pin Number

Pin Function

Type pin function

Enabled  Function
AMOOO
O AMNOOT
Il AMNO02
Il AMNO032
Il ANOM
Il AMO0S
Il AMNO0G
Il AMNOOT7
AVCCO
AVSS0
ADTRGOZ
VREFHO
VREFLO

Overview | Board | Clocks | Compeonent | Pins | Interrupt

Figure 4-43 Configure pin assignment - Config_S12ADO0

Assignment

Pin Mumber

| P40/1ROS/ANO0D

| 172

Mot assigned
Mot assigned
Mot assigned
Mot assigned
Mot assigned
Mot assigned
Mot assigned

Mot assigned
Mot assigned
Mot assigned
Mot assigned
Mot assigned
Mot assigned
Mot assigned

AVCCO

175

AV5S0

1

PO7/IRO15/ADTRGO
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WVREFHO

174

VREFLO

172

Direction
|

Mone
Mone
Mone
Mone
Mone
Mone
Mone

= O
&

Q| 0| e es

Remarks
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘felGenerate Code’ at location of Figure 4-44.

{84 5C_Tutorial.scfg 52 = (m]

Pin configuration

Figure 4-44 Generate Code Button

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘®tlGenerate Code’. The Console pane should report ‘Code generation is successful’, as shown Figure 4-45
below.

B Console 52
Smart Configurator OQutput

w;‘|=ﬂEv;=<J>v='E|

I
=

N A R R
Me4eeeeel: File generated:src\smc_gen\general\r_cg_dmac.h

Ma4eeeeal: File generated:srci\smc_gen\general\r_cg_sci.h

Ma4eeeeal: File generated:srch\smc_gen\general\r_cg_rspi.h

MB48BEBRL: File generated:src\smc_geni\general\r_cg_ppg.h

Ma4eeeeal: File generated:srchsmc_gen\general\r_cg_tmr.h

Ma4eeeeel: File generated:src\smc_gen\general\r_cg_lvd.h

Ma4eeeeal: File generated:srci\smc_gen\general\r_cg_dmac_user.c
Ma4eeeeel: File generated:srch\smc_gen\general\r_smc_entry.h

MB468e081: File generated:srch\smc_gen\general\r_cg_cmt.h

Ma4eeeeal: File generated:srch\smc_gen\general\r_cg_crc.h

MB4epeeel: File generated:src\smc_gen‘general\r_cg_doc.h

Ma4eeeeal: File generated:srch\smc_gen\general\r_cg_poe.h

Ma4eeeeel: File generated:srchsmc_gen\general\r_cg_riic.h

Ma4eeeeal: File generated:srci\smc_gen\general\r_cg_rtc.h

Ma4eeeeal: File generated:srchsmc_gen\general\r_cg_elc.h

MB5688012: File generated:src\smc_gen\r_pincfg\Pin.h

Maseeeal2: File generated:srch\smc_gen\r_pincfg\Pin.c

Mee@eeee2: File generated:src\smc_gen\r_confighr_bsp_interrupt_config.h
Maceeeeal: File generated:srci\smc_gen\r_config\r_bsp_irg_pricrity_cfg.h
Maceeeeaz: File generated:srchsmc_gen\general\r_smc_interrupt.c
MBEeRBBR2: File generated:src\smc_genigeneral\r_smc_interrupt.h
Macepeea2: File generated:src\smc_gen\general\r_bsp_icu_userdefine.h
Maeereea2: Code generation is successful

Figure 4-45 Smart Configurator console

4.6 Building the Project

The project template created by Smart Configurator can now be built. In the Project Explorer pane expand the
‘src’ folder then smc_gen folder.

[ Project Explorer &3 = <;==g> ¥ = 0
v [ SC_Tutorial
[ Includes
v [ src

v [= smc_gen
= Config_CMTO
7= Config_CMT1
= Config_CMT2
&= Config_ICU
&= Config_PORT
7= Config_S12AD0
= Config_SCI&
= Config_SCI&
= general
= rbsp
= r_config
= r_pincfg

[€) SC_Tutorial.c

&= trash

custom.bat

= SC_Tutorial HardwareDebug.launch

{8} SC_Tuterial.scfg

Figure 4-46 Generated folder structure

FE

Switch back to the ‘C/C++’ perspective using the button on the top right of the e? studio workspace. Use

‘Build Project’ from the ‘Project’ menu or the button to build the tutorial. The project will build with no
errors.
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5. User Code Integration

In this section, the remaining application code is added to the project. Source files found on the RSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code
generator files.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user needs to subsequently change any of the Smart Configurator-generated code.

5.1 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Locate the files ascii.h, r_okaya_lcd.h,
ascii.c, and r_okaya_lcd.c on the RSK Web Installer. These files can be found in the Tutorial project for e?
studio. Copy these files into the C:\Workspace\SC_Tutorial\src directory. The files will be automatically added
to the project as shown in Figure 5-1.

[y Project Explorer 33 3% ¥ = O

w =5 SC Tutorial [HardwareDebug]
9:;3 Binaries
[ml Includes
v [ src
= smc_gen
[€] ascii.c
[h] asciih
[£] rokaya_lcd.c
r_okaya_lcd.h
[€] SC_Tutorial.c
Figure 5-1 Adding files to the project
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In the e? studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’ by
double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for function. Do not edit comment generated here */

#define TRUE (¢D)
#define FALSE ()

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src’ folder and open the file ‘SC_Tutorial.c’ by double-clicking on it.
Add header files near the declarations ‘#include r_smc_entry.h'.

#include "r_smc_entry.h"
#include "r_okaya lcd.h"
#include "r_cg_userdefine._h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
user code area of the ‘main’ function:

void main(void)

{
/* Initialize the debug LCD */
R_LCD_Init(Q);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSK+RX65N-2MB ');
R_LCD_Display(1l, (uint8_t *)" Tutorial ');
R_LCD _Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
{
}

}
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5.1.1  SPICode

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.4.6. In
the e2 studio Project Tree, expand the ‘src\smc_gen\Config_SCI6’ folder and open the file ‘Config_SCI16.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI6_user.c file and insert the following code in the user area for global:
/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:

static void r_Config_SCI6_callback_transmitend(void)
/* Start user code for r_Config_SCI16_callback_transmitend. Do not edit comment generated here */
sci6_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_SCI16_SPIMasterTransmit
Description : This function sends SPI6 data to slave device.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

Ok X Ok X X X XN

MD_STATUS R_SCI6_SPIMasterTransmit (uint8_t * const tx_buf,
const uintl6_t tx_num)
{

MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
sci6_txdone = FALSE;

/* Send the data using the API */
status = R_Config_SCI6_SPI_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci6_txdone)

/* Wait */
}

return (status);

}

/
* End of function R_SCI6_SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.1.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in 84.4.2. Open the file
‘src\smc_gen\Config_ CMTO\Config_ CMTO0.h" and insert the following code in the user area for function at the
end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */

static volatile uint8_t one_ms_delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config_ CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r_Config_CMTO_cmiO_interrupt(void)

{
/* Start user code for r_Config_CMTO_cmiO_interrupt. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */

¥

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_CMT_MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds
* Arguments : uintl6_t millisecs, number of milliseconds to wait

* Return Value : None

void R_CMT_MsDelay (const uintl6_t millisec)
{

uintl6é_t ms_count = O;

do
{
R_Config_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_Config_CMTO_Stop();
one_ms_delay complete = FALSE;
ms_count++;
3} while (ms_count < millisec);
}
/
End of function R_CMT_MsDelay
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5.2 Additional include paths
Before the project can be built the compiler needs some additional include paths added. Select the
SC_Tutorial project in the Project Explorer pane. Right click in the Project Explorer window, and select

'Properties’. Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the £ button as shown in
Figure 5-2.

B8 Properties for SC_Tutorial

type filter text Settings =4 v
Resource -
Builders v B (i;mpl\er Include file directories LSl SRR .

=2 Source

v C/C++ Build g Obiect S{TCINSTALL}/include” ~

Build Variables %} X Jec $iworkspace loc:/${ProjNamel/src/smc_gen/r_bsp}”
Change Toolchain Versii (2 List "${workspace_loc:/${ProjNamel/src/smc_gen/r_config)”
v @ Optimize "${workspace_loc:/${ProjNamel/src/smc_gen/Config CMTO}"
@ Advanced "${workspace_loc:/${ProjName}/src/smc_gen/Config_CMTT}"
(8 Miscellaneous "${workspace_loc:/${ProjName}/src/smc_gen/Config_CMT2}"
5 | "${workspace_loc:/${ProjName}/src/smc_gen/Config_ICU}"
% ser "H{workspace_loc:/${ProjName}/src/smc_gen/Config_ PORT}"
Settings 2 Py "Sfwarkspace_loc:/$(ProjName)/src/sme_gen/Config_SCI8)"
P " \ . ET R SOy P "
Tool Chain Editor %’a PIC/PID @ loc.dtin L iCon i CrIE
C/C++ General b"; MISRA C Rule Check Preinclude files LA Iﬁ‘ %'
w B Assembler
(& Source
@ Object
& List
@ Miscellaneous
@ User
w B Linker
@ Input
(5 List
(22 Optimize Defines 2a8iy
@ Section

3 User [RX:2 | 5
@ Cancel
Figure 5-2 Adding additional search paths

\1

Dependency Scan
Device
Envircnment
Legging

v

Project References
Run/Debug Settings

In the ‘Add directory path’ dialog, click the ‘Workspace’ button and in the ‘Folder selection’ dialog browse to the
‘SC_Tutorial/src’ folder and click ‘OK’. e? studio formats the path as show in Figure 5-3 below.
P Add directory path

Directony:

| $iworkspace_loc:/${ProjMame}/src}

OK Cancel File system...

Figure 5-3 Adding workspace search path (1)

‘Settings’ dialog will appeatr, click ‘Yes’ to complete the include file directories.

@% Changes made will not be reflected in the index until it is rebuilt. Do you wish to
WY rebuild it now?

Yes No

Figure 5-4 Settings dialog

R v

Select ‘Build Project’ from the ‘Project’ menu, or use the button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSK+RX65N-
2MB Tutorial Press Any Switch’ on three lines in the LCD display.
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5.3 Switch Code Integration

API functions for user switch control are provided with the RSK+. Locate the files rskrx65n2mbdef.h,
r_rsk_switch.h and r_rsk_switch.c on the RSK Web Installer. These files can be found in the Tutorial project
for e? studio. Copy these files into the C:\Workspace\SC_Tutorial\src directory.

The switch code uses interrupt code in the files Config_ICU.h, Config_ICU.c and Config_ICU_user.c and timer
code in the files Config_ CMT1.h, Config_ CMT1.c, Config_ CMT1_user.c, Config_ CMT2.h, Config CMT2.c and
Config_CMT2_user.c as described in 84.4.2. and 84.4.3 It is necessary to provide additional user code in
these files to implement the switch press/release detection and de-bouncing required by the API functions in
r_rsk_switch.c.

5.3.1 Interrupt Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_ICU’ folder and open the file ‘Config_ICU.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */

uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);

void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */
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Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_ICU_IRQIsFallingEdge
* Description : This function returns 1 if the specified ICU_IRQ is set to
* falling edge triggered, otherwise O.
* Arguments : uint8_t irg_no
* Return Value : 1 if falling edge triggered, O if not
/
uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge trig = 0x0;
iT (ICU.IRQCR[irq_no]-BYTE & _04_ ICU_IRQ_EDGE_FALLING)
{
falling_edge_trig = 1;
}
return (falling_edge_trig);
3
/
* End of function R_ICU_IRQIsFallingEdge
/
/
* Function Name: R_ICU_IRQSetFallingEdge
* Description : This function sets/clears the falling edge trigger for the
* specified ICU_IRQ.
* Arguments  uint8_t irg_no
* uint8_t set_T _edge, 1 if setting falling edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_t set_f_edge)
if (1 == set_T_edge)
ICU.IRQCR[Lirg_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING;
}
else
ICU. IRQCR[Lirg_no].BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING;
}
/
* End of function R_ICU_IRQSetFallingEdge
/
/
* Function Name: R_ICU_IRQSetRisingEdge
* Description : This function sets/clear the rising edge trigger for the
* specified ICU_IRQ.
* Arguments  uint8_t irg_no
* uint8_t set_r_edge, 1 if setting rising edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
ifT (1 == set_r_edge)
ICU. IRQCRLirg_no].BYTE |= _08_ICU_IRQ_EDGE_RISING;
3
else
ICU.IRQCR[irg_no] -BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;
3
}
/
* End of function R_ICU_IRQSetRisingEdge
/
/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irgll_interrupt:

/* Start user code for r_Config_ICU_ irqll_interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R_SWITCH_IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg13_interrupt:

/* Start user code for r_Config_ICU_irql3_interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R_SWITCH_IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.3.2 De-bounce Timer Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT1' folder and open the
‘Config_CMT1_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "'r_rsk switch.h"

/* End user code. Do not edit comment generated here */

In the Config_ CMT1_user.c’ file, insert the following code in the user code area inside the function
r_Config_CMT1_cmil_interrupt:

/* Start user code for r_Config_CMT1 cmil_interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R_Config_CMT1_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT2' folder and open the file
‘Config_ CMT2_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "'r_rsk switch.h"

/* End user code. Do not edit comment generated here */

Open the Config_ CMT2_user.c file and insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r_Config_CMT2_cmi2_interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R_Config_CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();

/* End user code. Do not edit comment generated here */

R20UT3894EG0100 Rev. 1.00 RENESAS Page 47 of 66
May 31, 2017



RSK+RX65N-2MB 5. User Code Integration

5.3.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.4.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e2 studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h'.
Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

#define TRUE (¢D)
#define FALSE )

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the e2 studio Project Tree, expand the ‘src’ folder and Open the file ‘'SC_Tutorial.c’ and add the highlighted
code, resulting in the code shown below:

#include "r_smc_entry.h"
#include "r_okaya lcd.h"
#include "r_cg_userdefine._h"
#include "Config_S12ADO.h"
#include "'r_rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get_adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd _display_adc */
static void lcd_display adc (const uintl6_t adc_result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the

code shown below:

void main(void)

{
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX65N-2MB "*);
R_LCD_Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_Config_S12AD0_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
iT (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else iIf (TRUE == g_adc_complete)
{
/* Get the result of the A/D conversion */
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;
by
else
/* do nothing */
by
3
}

Then add the definition for the switch call-back, get adc and lcd _display_adc functions below the main

function, as shown below:

/

* Function Name : cb_switch_press

* Description : Switch press callback function. Sets g_adc_trigger flag.
* Argument I none

* Return value : none

static void cb_switch_press (void)

{
/* Check if switch 1 or 2 was pressed */
ifT (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))
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/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0x0;

¥
ks
/
* End of function cb_switch_press
/
/
* Function Name : get_adc
* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.
* Argument I none
* Return value : uintl6_t adc value
/
static uintl6é_t get _adc (void)
{
/* A variable to retrieve the adc result */
uintl6_t adc_result;
/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_Config_S12AD0_Stop();
/* Start a conversion */
R_S12ADO_SWTriggerStart();
/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
/* Wait */
3
/* Stop conversion */
R_S12ADO_SWTriggerStop();
/* Clear ADC flag */
g_adc_complete = FALSE;
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */
R_Config_S12AD0_Start();
return (adc_result);
ks
/
* End of function get_adc
/
/
* Function Name : lcd_display_adc
* Description : Converts adc result to a string and displays
* it on the LCD panel.
* Argument : uintl6é_t adc result
* Return value : none
/

static void lcd_display_adc (const uintl6_t adc_result)

/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char Icd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & O0xO0F00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);
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lcd_buffer[7] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & 0x000F);

Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD Display(3, (uint8_t *)lcd_buffer);

N

End of function lcd_display_adc

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_S12AD0’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,

resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */

void R_S12ADO_SWTriggerStart(void);
void R_S12ADO_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for

adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name: R_S12ADO_SWTriggerStart

* Description : This function starts the ADO converter.
* Arguments : None

*

Return Value : None

void R_S12ADO_SWTriggerStart(void)

IR(PERIB, INTB186) = OU;
IEN(PERIB, INTB186) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;

}

/
End of function R_S12AD0 SWTriggerStart

/

* Function Name: R_S12ADO_SWTriggerStop

* Description : This function stops the ADO converter.
* Arguments : None

*

Return Value : None

void R_S12ADO_SWTriggerStop(void)

S12AD.ADCSR.BIT.ADST = 0U;

IEN(PERIB, INTB186) = OU;

IR(PERIB, INTB186) = 0OU;
}

/
End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file Config_S12AD0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r_Config_S12ADO_interrupt(void)
/* Start user code for r_Config_S12ADO_interrupt. Do not edit comment generated here */
g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

}

-

Select ‘Build Project’ from the ‘Project’ menu, or use the button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the Tutorial to add the UART user code.
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54 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK+. Locate the files
r_rsk_debug.h and r_rsk_debug.c on the RSK Web Installer. These files can be found in the RSK+RX65N-
2MB_Tutorial project for e2 studio. Copy these files into the C:\Workspace\SC_Tutorial\src directory.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI8_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.5 UART Code Integration

55.1 SCI Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_SCI8’ folder and open the file ‘Config_SCI8.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD_STATUS R_SCI8 AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI8 user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci8_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI8_callback_transmitend function:

static void r_Config_SCI18_callback_transmitend (void)

{
/* Start user code for r_Config_SCI8 callback_transmitend. Do not edit comment generated here */
sci8_txdone = TRUE;
/* End user code. Do not edit comment generated here */

3

R20UT3894EG0100 Rev. 1.00 .zEN ESNS Page 53 of 66

May 31, 2017



RSK+RX65N-2MB 5. User Code Integration

In the same file, insert the following code in the user code area inside the r_Config_SCI8 callback_receiveend

function:

static void r_Config_SCI8 callback_receiveend(void)

{
/* Start user code for r_Config_SCI8 callback_receiveend. Do not edit comment generated here */
/* Check the contents of g _rx char */
iIT ((Cc” == g_rx_char) || ("C" == g_rx_char))
{
g_adc_trigger = TRUE;
}
/* Set up SCI8 receive buffer and callback function again */
R_Config_SCI18_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* End user code. Do not edit comment generated here */
3

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI8 AsyncTransmit
Description : This function sends SCI8 data and waits for the transmit end flag.
Arguments : tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

Ok X ok X X Ok XN\

/
MD_STATUS R_SCI8_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
sci8_txdone = FALSE;

/* Send the data using the API */
status = R_Config_SCI8 Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci8_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI8_ AsyncTransmit
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55.2 Main UART code

Open the file ‘SC_Tutorial.c’. Add the following declaration to near the top of the file:

#include "r_smc_entry.h"
#include "r_okaya_lcd._h"
#include "r_cg_userdefine._h"
#include "Config_S12ADO.h"
#include "'r_rsk switch.h"
#include "r_rsk debug.h"
#include "Config_SCI8.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display_adc (const uintl6_t adc_result);

/* Prototype declaration for uart_display_adc */
static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

{
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init();
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX65N-2MB *);
R_LCD_Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_Config_S12AD0_Start();
/* Set up SCI8 receive buffer and callback function */
R_Config_SCI18_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI8 operations */
R_Config_SCI8_Start();
while (1U)
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SwW2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count */
if (16 == (++adc_count))
adc_count = 0;
by
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
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}

}
/*

/* Reset the flag */
g_adc_trigger = FALSE;

SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

}

/* Get the result of the A/D conversion */
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == (++adc_count))

adc_count = 0;

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

else

{

}
}

/* do nothing */

Then, add the following function definition in the end of the file:

o o X XN

Function Name : uart_display_adc
Description : Converts adc result to a string and sends it to the UARTL.
Argument : uint8_t : adc_count

uintl6é_t: adc result

Return value : none

static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)

{

}

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: »xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0OxOF00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0x00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

/

/

* End of function uart_display_adc

/

Select ‘Build Project’ from the ‘Build’ menu. e? studio will build the project with no errors.

The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM &
LPT)' as 'RSK USB Serial Port (COMXx)', where x is a number.
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Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI8 (see §4.4.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC

terminal program via the SCI8. Return to this point in the Tutorial to add the LED user code.

5.6 LED Code Integration

Open the file ‘SC_Tutorial.c’. Add the following declaration to the near the top of the file:

#include "r_smc_entry.h"
#include "r_okaya lcd.h"
#include "r_cg userdefine_h"
#include "Config_S12ADO.h"
#include "r_rsk_switch._h"
#include "r_rsk _debug.h™
#include "Config_SCI8.h"
#include "rskrx65n2mbdef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* Prototype declaration for cb_switch_press */
static void cb_switch_press (void);

/* Prototype declaration for get_adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd _display_adc */
static void lcd_display_adc (const uintl6_t adc_result);

/* Prototype declaration for uart_display_adc */

static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */

static uint8_t adc_count = 0;

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code in the main function:

void main(void)

{
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init();
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX65N-2MB **);
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_Config_S12AD0_Start();
/* Set up SCI8 receive buffer and callback function */
R_Config_SCI18_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI8 operations */
R_Config_SCI18_Start();
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while (1U)
{

}

uintl6é_t adc_result;

/* Wait for

if (TRUE == g_adc_trigger)

{

/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == (++adc_count))
{

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */

g_adc_trigger = FALSE;

ks
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

}

/* Get the result of the A/D conversion */
R_Config_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == (++adc_count))

adc_count = 0;
led_display_count(adc_count);
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

else

}

/* do nothing */

user requested A/D conversion flag to be set (SW1 or SwW2) */
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Then, add the following function definition at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument I uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t)((count & 0x01) ? LED_ON : LED_OFF);
LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED_OFF);
LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED_OFF);
LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF);
ks
/
* End of function led_display_count
/

}®

Select ‘Build Project’ from the ‘Build’ menu, or use the
errors.

" button. e? studio will build the project with no

The project may now be run using the debugger as described in 86. The code will perform the same but now

the LEDs will display the adc_count in binary form.

R20UT3894EG0100 Rev. 1.00 RENESAS
May 31, 2017

Page 59 of 66



RSK+RX65N-2MB

6. Debugging the Project

6. Debugging the Project

In the Project Explorer pane, ensure that the ‘SC_Tutorial' project is selected. To enter the debug

configurations, click upon the arrow next to the debug

PR Debug Configurations

Create, manage, and run configurations

ek A=

type filter text

] C/C++ Application

[] C/C++ Remote Application

=/ EASE Script

[©] GDB Hardware Debugging

[ ] GDB OpenOCD Debugging

[£7 GDB Simulator Debugging (RHA50)
Java Applet
Java Application

= Launch Group

[EL Remote Application

fﬁ, Remote Debugger
Remote Java Application

~ [c7 Renesas GDB Hardware Debugging

SC_Tutorial HardwareDebug

[£7 Renesas Linux Application

[£7] Renesas Simulator Debugging (R¥, RL78)

FE Target Communication Framewaork

Filter matched 17 of 19 items

@

button and select ‘Debug Configuration’.

Name: | SC_Tuterial HardwareDebug

[ Main %5 Debugger| = Startup| % Source| 7] Common

Project:

| S5C_Tutorial

Browsze...

C/C++ Application:

| HardwareDebug/5C_Tutorial x

Build (if required) before launching

Build Configuration: | Select Automatically

() Enable aute build
(®) Use workspace settings

Variables... Search Project... Browse...

() Disable auto build
Configure Workspace Settings...

Revert Apply

Figure 6-1 Debug Configurations

In order to run the project there are two setting under ‘Renesas GDB Hardware Debugging’ -> ‘Debugger’ ->
‘Connection Settings’ that need modifying.
Ensure that in debug configuration that the ‘Power Target From The Emulator(MAX 200mA)’ is set to No , and
the ‘Extal Frequency’ is set to the correct frequency, this can be found from the device schematics (in the case
of RSK+RX65N-2MB the setting should be 24.0000).
For more information on powering the RSK+RX65N-2MB please refer to the User Manual.

v Cock

Main | %5 Debugger [ Startup | [-] Commen . Source

Debug hardware: |E2 Lite (RX]) ~ | Target Device: | R3F365ME

GDB Settings Connection Settings  Debug Tool Settings

Main Clock Source
Extal Frequency[MHz]

~ Connection with Target Board

Supply Voltage

w CPU Operating Mode
Register Setting
Mode pin
Change startup bank
Startup bank

EXTAL
24,0000

Permit Clock Source Change On Writing | Yes

Emulator (Auto)
Connection Type ITag
ITag Clock Frequency[MHz] 6.00
Fine Baud Rate[Mbps] 1.50
Hot Plug MNe

v Power

Power Target From The Emulator (MAX 2

3.3V

Single Chip
Single-chip mode

Mo
Bank 0

Figure 6-2 Connection Settings
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Connect the E2 Lite to the PC and the RSK+ E1/E2 Lite connector. Connect the Pmod LCD to the PMOD1
connector.

Connect the center positive +5V PSU to the PWR connector on the RSK+ and apply power.

In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To debug the project, click the

L button. The dialog shown in Figure 6-3 will be displayed.

P8 Confirm Perspective Switch

"-.I This kind of launch is cenfigured to cpen the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It incorporates
views for displaying the debug stack, variables and breakpoint management.

Do you want to open this perspective now?

Yes No

Figure 6-3 Perspective Switch Dialog

Click ‘Remember my decision’ to skip this dialog later. Click ‘Yes’ to confirm that the debug window
perspective will be used. The debugger will start up and the code will stop at the Smart Configurator function
‘PowerOn_Reset PC’ as shown in Figure 6-4.

lo?] Workspace - Debug - SC_Tutori, n/r_bsp/board/generic_mxb5n/resetprg.c - e2 studio

File Edit Source Refactor Mavigate Search Project RenesasViews Run Window Help

%@: Debug ~ SC_Tutorial HardwareDebug ~ A ‘ o

%5 Debug 52
~ [£7] SC_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
~ [ 5C_Tutorialx [1]
w o Thread #1 1 (single core) (Suspended : Signal : SIGTRAP:Trace/breakpoint trap)
= PowerOM_Reset_PC() at resetprg.c:125 Onffel156e
s Ci/Renesas/e2studio_6.0.0.009/e2_studio_6.0.0.009_win32_x86/DebugComp/ri-elf-gdb -ri-force-v2 (7.8.2)
s GDB server

[ resetprg.c 22
S ffeelSée - poid PowerON_Reset_PC(void)
6

/* Stack pointers are setup prior to calling this functieon - see comments

/* Initialize the Interrupt Table Register */
ffe@l57c set_intb({void *)_ sectop("CEVECT"));

/* Initialize the Exception Table Register */
ffe@1585 set_extb((void *)_ sectop("EXCEPTVECT"));

/* Initialize FPSW for floating-point operations */

- #ifdef _ ROZ
#define FPU_ROUND 8x88808801 /* Let FPSW RMbits=Bl (round to zero) */
- #else
#define FPU_ROUND @xee@epeeee /= Let FPSW RMbits=ee (round te nearest)
#endif
= #ifdef _ DOFF
#define FPU_DENOM @x@@@@@le@ /* Let FPSW DNbit=1 (denormal as zero)
- #else
#idefine FPU_DENOM 9x00000000 /* Let FPSW DNbit=0 (denormal as is) */
#endif
7 ffee1592 set_fpsw(FPSW_init | FPU_ROUND | FPU_DENOM);

/* Switch to high-speed operation */
. +ine Frmminnee oa AN

Figure 6-4 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the L
button. The debugger will stop again at the beginning of the main function. Press B again to run the code.
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7. Additional Information

Technical Support

For details on how to use e? studio, refer to
the help file by opening e? studio, then
selecting Help > Help Contents from the | Window | Help

menu bar. & v @ id) Welcorne

{(7) Help Contents
7 Search
Dynarnic Help

For information about the RX65N group microcontroller refer to the RX65N Group, RX651 Group Hardware
Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details
Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2017 Renesas Electronics Europe Limited. All rights reserved.
© 2017 Renesas Electronics Corporation. All rights reserved.
© 2017 Renesas System Design Co., Ltd. All rights reserved.
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